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1. INTRODUCTION TO THE AMAZON DIGITAL TEXT PLATFORM

Amazon’s Digital Text Platform, or DTP, is a conversion tool used to create content for the

Kindle ebook reader device, and put that content up for sale in the Amazon Kindle Store. You

cannot use the DTP to create Kindle editions of your work for your own personal use, the

content creation process automatically generates an accompanying Amazon product page.

2. WHY PUBLISH WITH DTP?

Assuming you’ve already made the decision to self-publish, there are some very good reasons

to go with Amazon DTP. The Kindle is the dominant dedicated ereader device currently on the

market, and the ebook market has been growing at a rate of around 400% year over year since

2007. It’s simply too large a market sector for authors and publishers to ignore. Publishing your

book in Kindle format via Amazon’s DTP is free, and doing so gets your work onto the virtual

shelves at Amazon in a matter of days.

Also, it’s no longer true that only Kindle owners will be able to buy and read your Kindle book:

Amazon has released free Kindle reader “apps” that run on PCs, Macs, smart phones, the iPad,

the iPod Touch, the iPhone, Blackberrys, and numerous other devices. About the only people

left out of the Kindle book party are those who only read ebooks on competing, dedicated

devices (e.g., the Sony Reader). Releasing a Kindle edition of your book can be a very cost-

effective trial for a book you’re considering releasing in print formats. And here’s one more

thing to consider: my Kindle edition, self-published books outsell my print editions of the same

books at an average rate of 100 to 1. While it’s true that my royalty on those Kindle book sales

are only about half the royalty on my print editions, I more than make up for the shortfall in

volume.

There are certain marketing advantages to publishing your book in Kindle format as well. First,

Kindle owners and people who otherwise read Kindle books are a specific population; it’s easy

to target your promotional efforts by seeking out their blogs and discussion groups. Second,

because the Kindle book store has a much more limited inventory than the ‘regular’ Amazon

book store, you don’t have to sell as many copies of your DTP book to quickly rise into the

Kindle store bestseller ranks. Finally, because Amazon book listings combine reviews and sales

figures from all available editions of a given book, you can use your DTP edition to accumulate
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sales and reviews to support a later POD release in the ‘regular’ book store. If you do this, the

day your POD book goes on sale, it can already have sales and positive reviews associated with

it from the Kindle book store.

3. SOME QUESTIONS AND ANSWERS ABOUT THE DTP

3.1. WHO CAN USE THE DTP?

As of this writing, anyone with an Amazon account can use the DTP to create and sell

Kindle editions of anything from short fiction to doorstop-sized tomes.

3.2. IN GENERAL, HOW DOES IT WORK?

You begin by entering details about your book, such as title, category, author name(s),

keywords, description, etc. You specify your sales channel preferences (e.g., Amazon US

only, or Amazon UK also?) and verify your rights to the material. You also specify which

royalty option you’d prefer, 35% or 70% (more on this later). Next, you upload your

pre-formatted manuscript and cover art. When the upload is complete, you can preview

what your manuscript will look like on the Kindle from your web browser screen. If all

looks correct, the final step is to set your price, save your changes, and then ‘Publish’

with one final button click.

3.3. WHAT DOES IT COST?

There is no cost to set your book up for sale as a Kindle edition via the DTP.

3.4. HOW LONG DOES IT TAKE?

It takes anywhere from 20-45 minutes to fill in the necessary online forms, upload and

preview your DTP edition. From the time you click the ‘Publish’ button, signifying your

approval of your book, its details and the associated cover art, it takes approximately 3

business days for your book to show up in the Kindle book store as “available for

purchase”. However, it will take up to another two weeks for all of your book’s details to

be fully populated on the book’s listing page (e.g., your brief description).
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If you’ve previously released a print edition of the same book for sale on Amazon, it can

take up to six weeks for the two editions to become “linked” to one another on the

Amazon site. This “link” allows people viewing your book’s Kindle page to see it’s also

available as a print edition, and vice-versa, and it causes all reviews of any edition of the

book to display on every edition’s product listing page.

It can take up to twelve weeks for your Kindle book to show up on the Amazon UK site,

if you’ve opted in for Amazon UK sales.

3.5. WHAT RIGHTS DO I GIVE UP WITH DTP?

First, the usual caveat: legal advice is outside the scope of this article, and full disclosure

on the matter can be found in the DTP Terms and Conditions, which can be accessed at

http://forums.digitaltextplatform.com/dtpforums/entry.jspa?externalID=2&categoryID=3

2. If the document should be moved at some point in the future, rendering the provided

link broken, just go to http://dtp.amazon.com, click the Support link, and do a search on

“Terms & Conditions” in the support area. You can also usually find a link to the Terms

& Conditions page at the bottom of any page in the DTP part of the Amazon site.

Having said that, in agreeing to the Terms & Conditions you’re granting Amazon sole

right to sell, distribute and promote the Kindle edition of your work, as created by the

DTP, in whatever manner they see fit. You’re agreeing to let them share free digital

excerpts and images of your work taken from the Kindle edition (i.e., ‘Search Inside the

Book,’ ‘Read A Free Excerpt,’ etc.), as well as to discount, bundle or cross-sell your

Kindle edition work as they wish.

You’re also granting them the right to release the work to customers who buy it, store

the work on their servers or the servers of their designee(s), and store the work on

behalf of purchasers in each purchaser’s ‘digital locker’.

You are not giving up any other rights to publish any other editions of your work, not

even other ebook editions. Given that the Kindle file format is proprietary and specific to

the Amazon DTP, it’s not as if standalone DTP/Kindle rights could ever be sold to

another entity anyway. Still, it’s worth mentioning that this is still a form of self-
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publishing, so any agent or publisher with an anti-self-publishing stance will probably be

turned off by publication of your Kindle book regardless of your largely intact rights.

There are more details in the Terms & Conditions, and I urge you to read it in its

entirety, and even consult with an attorney about it if you have any doubts, before you

decide whether or not to use the DTP.

3.6. CAN I OFFER THE SAME EBOOK FOR SALE ELSEWHERE IN

DIFFERENT FORMATS?

Yes. Amazon’s DTP Terms of Service prohibit you from offering a Kindle edition at a

lower price outside of Amazon’s Kindle book store, but place no limitations on how you

price the same ebook when it’s offered in different formats through other vendors. So

you could publish the same book in epub and Sony Reader formats through

Smashwords, for example, and price those editions however you like: their prices do not

have to match the Amazon Kindle edition’s price.

3.7. DOES MY KINDLE BOOK NEED TO HAVE A PRE-ASSIGNED ISBN?

No, and you don’t have to purchase one for your DTP book, but I strongly suggest that

you do anyway. I make this suggestion because things are changing in the ebook world,

and retailers such as Barnes & Noble and Apple’s iBookstore already require ISBN

assignment for every ebook they stock. While Amazon doesn’t yet have the same

requirement, I think it’s only a matter of time until it will. You can purchase ISBNs

individually or in blocks at http://www.myidentifiers.com. As of this writing, it’s US$150

for a single ISBN/barcode block.

If money is simply too tight for you to be able to afford an ISBN for your Kindle book,

then go ahead and skip it. But be prepared for the possibility that at some point in the

future, Amazon may require you to purchase and retroactively assign an ISBN to your

Kindle book.
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3.7.1. DO DIFFERENT VERSIONS OF THE SAME EBOOK NEED

DIFFERENT ISBNS?

As to the question of whether or not each different ebook edition (e.g., Kindle book,

iBook, Sony Reader book, etc.) requires a unique ISBN, this one has yet to be

definitively decided. When you consider first that ISBNs are a tracking tool, and second

that in the “hard” media world different editions of the same book (e.g., hard cover,

trade paperback, mass market paperback, audio CD) must each have a separate, unique

ISBN, it seems logical that each different ebook edition should also have a separate,

unique ISBN assigned. But since ebooks are relative newcomers to the trade publishing

and book retailing scene, firm guidelines for ISBN assignment on ebooks have yet to be

established.

As of this writing, if you publish your ebook in multiple formats (e.g., Kindle, Sony

Reader, .epub, etc.) through Smashwords and opt in for the Premium Catalog (which

requires ISBN assignment), you’re still only required to assign a single ISBN to the

source ebook file you upload to Smashwords’ servers. The Smashwords conversion

process can spit out several different ebook formats at the back end, but every one of

them will have the same ISBN assigned. This kind of makes sense, when you consider

that the ebooks can all be traced back to the same, single source file which is stored on

Smashwords’ servers, and Smashwords is acting as a distributor for the content. It’s as

if there’s really only one ebook, and Smashwords is merely providing copies of it in each

vendor’s preferred file format.

However, if all your ebook editions can’t be traced back to the same source file and you

are not working with a centralized distributor, the story’s a little different.

For example, if I use the Amazon DTP to publish my own Kindle edition to be sold in

Amazon’s Kindle book store, then use the Apple Pages app to create an iBook version of

the same ebook to be sold in Apple’s iBookstore, then hire an intermediary to create a

third version to be sold in the Sony Reader store, there isn’t a single source file sitting

on a distributor’s server somewhere to which all those various editions can be traced

back. In that case, it seems to make more sense to assign each different ebook edition

its own ISBN.
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Given that the ISBN agency itself is pushing for each different ebook edition to be

assigned a unique ISBN, I think that’s the direction things are going. And again, it does

make sense. A Kindle book is to an iBook as a trade paperback is to a hardcover: same

content, but different packaging and presentation. So if the hardcover and trade

paperback of the same book have to be assigned different ISBNs, why shouldn’t the

same hold true for different editions of an ebook?

Note that one ISBN rule which does already exist is this: each different edition of a book

(i.e., audiobook, hardcover, trade paperback, ebook) must be assigned a unique ISBN.

This means you cannot assign the ISBN used for some other edition of your book (e.g.,

hardcover, trade paperback, etc.) to an ebook edition.

Again, bottom line: if you can afford to buy and assign a unique ISBN to each different

edition of your ebook, that’s probably a good idea and very forward-thinking. If you can

only afford to buy one ISBN for all your ebook editions, that’s still better than no ISBN at

all and will qualify your book to be published or distributed through outlets which require

an ebook ISBN. If you can’t even afford to buy one ISBN, you can still publish a Kindle

book through the DTP without it.

3.8. WHAT IS MY AUTHOR ROYALTY ON MY DTP BOOK?

As you probably already know, Amazon offers two different royalty options to authors: a

35% option and a 70% option. You might think this is a no-brainer, and no author in

her right mind would choose the 35% option when 70% is also available, but there are

pros and cons to each. The single most important consideration is probably this: do you

intend to offer the same ebook in different formats outside the Amazon Kindle book

store? If so, you will probably want to stick with the 35% royalty option, for the reasons

to follow.

3.8.1. 35% ROYALTY OPTION

The main advantage of the 35% royalty option is predictability. With this option, your

author royalty is 35% of the list price you set when you enter the details for your DTP

book—regardless of the price at which the book is ultimately sold.
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For example, if you price your book at $4.99, your royalty on each copy sold is $1.75.

Even if Amazon discounts your book and sells it for say, 20% off the list price, you still

get $1.75 for each copy sold. Amazon likes to goose its Kindle book sales with frequent

discounts, but if you’ve selected the 35% royalty option, Amazon’s discounts will have

no impact on your royalties.

Furthermore, if you’ve published the same ebook in different formats elsewhere (e.g.,

on Scribd, via Smashwords, etc.), the pricing you’ve set for those different editions will

have no impact on your DTP Kindle book’s price or your resulting royalty on each sale.

3.8.2. 70% ROYALTY OPTION

With the 70% option, your royalty is 70% of the price at which the Kindle book is

actually sold, not the retail price you set. So if you’ve priced your Kindle book at $4.99

and Amazon discounts it to $3.99, your royalty will be 70% of $3.99, not 70% of $4.99.

This may not seem like much of a financial hit to take, since 70% of $3.99 is still more

than 35% of $4.99. However, when Amazon discounts its Kindle books it tends to

discount them pretty deeply. My own Kindle novels, which I’ve priced at $2.99, are

currently marked down to $.99 on Amazon. 70% of $.99 is less than 35% of $2.99, so

I’m glad I’m in the 35% royalty boat.

The other major downside of the 70% royalty option is the “price parity” requirement

that comes along with it. In plain English, this means that your Amazon Kindle edition

cannot ever be offered at a price higher than you’re offering the same ebook for sale

elsewhere—even if you’re only offering it in non-Kindle formats elsewhere. From the

time you opt in for the higher royalty, Amazon regularly sends out ‘crawlers’ to scan the

entire internet, looking for copies of your ebook being offered at a lower price anywhere

else online. And if a crawler finds the book priced lower elsewhere—even if it was the

retailer, not you, who discounted it—Amazon will immediately drop the price of your

Kindle book on their site to match the lowest price found elsewhere. Since you have no

control over what other retailers choose to do on their own sites, this factor makes your

royalties totally unpredictable if you’re offering the same ebook for sale through any

vendor other than Amazon.
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3.8.2.1. DOES IT EVER MAKE SENSE TO CHOOSE THE 70% OPTION?

There’s only one set of circumstances under which I’d recommend the 70% royalty

option:

1. You are only publishing your ebook in Kindle format, via the DTP

2. You are only offering the Kindle ebook for sale on Amazon’s site(s)

That’s it. While you’ll still have to ride out Amazon’s periodic discounting, over time

you will make up for those royalty dips with the much higher royalty you’ll be

receiving when your Kindle book is not discounted. Otherwise, if your ebook is to be

made available through other retailers and outlets, the discounting issue is simply

too big an unknown.

3.9. HOW HARD IS IT, REALLY?

Well, it’s gotten considerably harder recently, now that Amazon requires all Kindle

books to have an active Table of Contents file (toc.ncx) included as part of the

uploaded file package when you publish through the DTP. This is not the same as a

hyperlinked Table of Contents, which has always been recommended for Kindle

books and is very easy to create in Word.

On the Kindle device and in most Kindle reader apps, there’s a progress bar on the

bottom of the screen which shows how far into the book the current page is, how

much has already been read and how much remains to be read. The progress bar

also has little tick marks indicating major bookmarks, such as for the start of each

chapter, the very first page of the book, the Acknowledgements, the Table of

Contents and so on.

Those tick mark titles and locations are collected in a separate “menu” page for each

Kindle book. The “menu” page consists of a table of hyperlinks the reader can use to

quickly jump around in the book, sort of like jumping right to a certain “chapter”

when watching a DVD or Blu-Ray disc.
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The progress bar and menu file only work if the book has a correct toc.ncx file and

the tick marks / titles are properly defined within that file.

The toc.ncx requirement adds a whole new level of complexity to the Kindle

publishing process because the file is written in XHTML and, as of this writing,

there’s no automated way to get properly-functioning toc.ncx file out of your Word

manuscript.

And it’s not for nothing that this guide is over 50pp long. You’ll have to properly

format your document and cover image, import them to Mobipocket Creator,

monkey around a bit with some HTML and XHTML files, convert the ebook file to a

different format for upload to the DTP, preview its contents following conversion,

then set up your book project on the DTP and upload your file.

This guide will explain how to do all of those things in step-by-step, plain English

language, but you should expect to spend several hours going through the process—

and about double that amount of time on your first attempt. As you might expect,

the more and better your computer skills, the easier it is to do a good and smooth

job of things.

Be warned: this stuff isn’t for the tech faint of heart. Your chances

of success are pretty much directly proportional to your experience and

comfort level in working with HTML and other computer code files. If you’re

the adventurous type who’s inexperienced but willing to learn, there’s

certainly no harm in giving this a try. Just be aware that when working with

computer code files, all it takes is a single wrong or missing character to

make the entire thing nonfunctional. If the going gets too frustrating, your

only Plan B is to get someone else to do the Kindle conversion for you.

Images will complicate things considerably but even if your book does have images

in it, so long as your text doesn’t have to “flow” around them (such as the way text
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flows around a picture in a magazine article), it’s still manageable for anyone with

intermediate graphic or photo editing skills. If you know what “dpi” means and know

how to edit or reformat images to reduce their file size, you should be fine.

3.10. CAN YOU ANSWER MY TEN MILLION OTHER QUESTIONS?

No, but the folks at Amazon DTP can. Go to http://dtp.amazon.com, click the ‘Help’

link, and avail yourself of the Getting Started Guide, Formatting Guide, FAQ and

Additional Information links. Also feel free to peruse the Ask The Community user

forums, as many specific questions, concerns, tricks and tips are also discussed

there.

4. GETTING READY FOR THE DTP

First things first: as mentioned above, it’s a very good idea to go to http://dtp.amazon.com,

click the ‘Help’ link, and avail yourself of the Getting Started Guide, Formatting Guide, FAQ and

Additional Information links. The links will take you to help pages where you can download pdf

guides, tutorials, and a quick start guide. Grab a copy of everything available, and read all of it.

Then come back to this document for a simpler set of instructions that also cover some tips,

tricks and gotchas not included in Amazon’s materials.

You will have to provide a tax ID number (i.e., social security number) and bank information in

order for Amazon to pay you your author royalties. Don’t get all paranoid about this, because

any author must provide a tax ID number to his or her publisher, and the bank information is

only needed so that Amazon can electronically transfer your royalties directly to your bank

account instead of cutting and mailing a check.

5. DON’T USE ANYTHING LESS THAN A FINAL, ‘LOCKED’ DRAFT

Remember, once you click that ‘Publish’ button your work is on its way to the Kindle store

shelves for the whole world to see. Do not publish anything via DTP that you would not feel

comfortable seeing on the shelf at your local brick-and-mortar bookstore with your name on the

cover. This is not the time or place for anything less than a final, completely polished draft that

you’ve ‘locked’ against more revisions.
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Your manuscript should be a ‘proof,’ containing all the same content you would expect to

include in a file being sent to press for creation of a paper book: publication details page, title

page, table of contents (even in a novel, this is required for a Kindle book on account of the

toc.ncx requirement), dedication page, ‘About the Author’ page at the back, ‘Other Titles From

[your name]’ page, prologue and/or epilogue if applicable, etc.

6. PREPARE YOUR COVER ART

Kindle store customers judge the lack of cover art, or the presence of unaltered stock-photo

cover art, to be a hallmark of the non-professional. You definitely want some nice cover art for

your DTP book, and you want it to match the cover art of all other editions of your book for

consistency’s sake. Even if you don’t have any other editions available yet, don’t skimp on the

time or effort here because whatever you create for DTP will have to serve for possible future

POD books.

You don’t need a top-of-the-line graphics program to create this cover art, however. Anything

from a greeting card program to MS Paint can get the job done, but of course a dedicated

graphics or photo editing program will generally offer more and better options. You can use any

public domain or purchased clip art in your cover image, but you may not use graphics copied

off the internet unless their creator has explicitly given permission for commercial re-use of the

image(s).

Also be aware that, apart from photos in purchased clip art and stock photo collections, if you

intend to use a photo in which anyone’s face is recognizable, you must have a written and

signed release from every living person who is recognizable in the photo. If any of those people

are celebrities, even if the person is dead you may have to obtain a written and signed release

from surviving family members. It’s best to avoid these hassles entirely by sticking to purchased

clip art and stock photos.

There are entire books and websites dedicated to the subject of how to create compelling book

covers, but the most important thing to know for purposes of this document is that your cover

art must meet Amazon product image standards: TIFF (.tif/.tiff) or JPEG (.jpeg/.jpg) format,

with image pixel dimensions of at least 1000 pixels on the longest side. Color mode must be

“sRGB” (this is the default for most graphics programs), not “CMYK”, and of course you’re going
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for a typical, rectangular shape and proportion such as you’re used to seeing on any book.

Refer to your graphics program documentation or help files for more information on how to

create or edit your cover art to meet these requirements.

7. CRAFT YOUR BOOK DESCRIPTION

You are only given 4000 characters, including spaces, for your book description in the Kindle

store, which will appear on your Amazon product page when the book is released. Look at a

few such descriptions for bestsellers in the Kindle store to get some idea of how to approach

this. You’re going for a synopsis that says enough about the story to lure a reader in, but

doesn’t give away too much.

Create a separate Word or .txt document just for the description, so you can spend some

quality time working and reworking it until it’s exactly what you want.

8. PREPARING YOUR MANUSCRIPT FOR DTP

This article assumes you have a copy of your manuscript in MS Word 2003 or higher and you’ve

already created your cover art and description. While it is possible to upload any manuscript

formatted as HTML or prc to the DTP, the method described here is specific to using MS Word

2003 or higher.

8.1. ‘SAVE AS’ TO CREATE A COPY FOR DTP

Your manuscript is probably formatted according to print publishing conventions:

double-spaced, wide margins, etc. You will need to change many of these settings for

your DTP edition, so create a copy of the manuscript just for DTP formatting.

8.2. MODIFY YOUR FORMATTING TO MAKE IT HTML-COMPLIANT

I’m not going to lie to you…this part of the process is not fun. But as an intermediary

step during the Kindle book creation process your manuscript will be converted to an

HTML file in which most of your Word formatting options will be lost, along with any

special characters such as Webding symbols. Therefore, to save yourself from

unwelcome formatting surprises after you upload to DTP, you want your text to be as

minimally-formatted as possible.
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Note that if your manuscript includes illustrations, diagrams or other graphics, the

images should be provided in a resolution of at least 300dpi and ideally, in color (if

applicable). If you don’t know how to verify or alter your images’ resolution setting, you

can go with them as-is, but you’ll need to review them in the converted file before you

publish it; if they come out fuzzy or “jaggy” at the other end of the conversion process,

you may want to think about omitting them entirely, if possible. If the images are

critical, you’ll have to hire someone who knows how to work with ebook images to do

the ebook conversion for you.

Moderate to advanced HTML skills are required if you need to tightly control the location

of each graphic/picture on the page, or the way your text ‘wraps’ around the graphic in

a page; such HTML instruction is beyond the scope of this document, so the instructions

here assume you do not need or want that level of formatting control.

As you go through the following steps, save frequently (still in Word format---you won’t

convert to any other format until all changes and corrections have been made).

1) Delete the extraneous, add the necessary

a) Delete any blank pages that were inserted into the original manuscript for
purposes of ‘facing pages’ formatting. Delete your headers and footers,
as they’ll be lost in the conversion process anyway. Don’t worry about
losing your page numbers, as the Kindle automatically regenerates digital
page numbers each time it loads a file. If you haven’t already done so,
insert a Title Page at the front of your manuscript with your book’s title,
your name and any copyright information (if applicable).

Just in front of that, insert a 4x6” image of your book’s front cover, in
color and at a resolution of 300dpi, as the very first page of your file and
enter a page break immediately after it.

While you’re at it, it’s actually a good idea to use color versions of any
images in your Kindle book. While the most recent Kindle device can’t yet
display ebooks in color, Kindle reader apps that run on color devices do,
and it’s highly likely a future Kindle device will have a color display. Your
color images will display properly, though only in grayscale, on a Kindle
device that doesn’t display colors, but will be shown in all their full-color
glory in the apps that do show colors. And when a color Kindle comes out
in the future, while other authors are scrambling to re-publish with their
images and cover in color, you can just sit back and relax.

2) If you’ve used Styles in your manuscript, clean them up
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a) In the course of writing and revising, you may have inadvertently
formatted various sections of your text with differently-named Styles.
This can happen when you need to switch from one Style to another, say
from Chapter Heading to Body Text, and instead of selecting the correct,
pre-existing Style from the Styles list, you manually apply format changes
to your text blocks on the fly. Make sure that all like-formatted sections of
text have the same Style applied to them.

3) Modify your margins and line spacing

a) Change your margins to no more than 1” all around, and change your
body text line spacing from double-spaced to 1.5 line spacing throughout.
Double-spaced text takes up an annoying amount of screen real estate on
an ebook reader, and all that extra white space doesn’t actually improve
its readability.

4) Ensure your text is HTML-friendly

a) HTML can render body text, indented text blocks, numbered or bulleted
lists, and simple tables, as well as italics, boldface and enlarged text. It
can render only a handful of fonts, with Arial, Tahoma and Verdana being
the most commonly-used and easy to read. Font size should be set to 10-
pt or 11-pt, depending on your chosen font, for easy readability. You can
use a larger font size, but since the Kindle has an enlarge text function
it’s not really necessary. Even on the title page, your font size should be
no larger than 14pt. Make any needed changes to your manuscript so
that its contents will meet these fairly limited parameters.

5) Omit extraneous carriage returns, page breaks and section breaks

a) Section breaks will not be recognized in the HTML conversion, but page
breaks will. It’s appropriate to use page breaks at the end of each
chapter, and to consistently insert one or two carriage returns at the start
or end of each chapter to break them up visually, but delete any carriage
returns that were used to try and fudge line spacing, widow or orphan
control in printed manuscript copies.

Also delete extraneous carriage returns which may have been used to
offset differently-formatted sections of text, but are no longer necessary
now that your formatting is being greatly simplified. HTML will interpret
each carriage return as the start of a new paragraph, and may insert
unwanted blank lines between those paragraphs.

6) Use Search and Replace to locate and delete or replace any special
characters

a) For example, if you’ve used a bullet icon such as a star or snowflake as a
graphic element to create dividers between sections of text, you will need
to delete those bullets or replace them with a regular character, such as
an asterisk or dash. HTML has its own set of supported special
characters, but unless you’re well-versed in HTML it’s safer and easier to
just fall back on standard keyboard characters.
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b) Subscripts and superscripts are also not likely to translate properly; locate
all such instances and reformat accordingly

7) Edit each graphic to conform to Kindle requirements

a) Edit each graphic file used within the body of your book (as opposed to
the cover image on the first page) so that its dimensions are no larger
than 450 x 550 pixels, its file size is no larger than 64kb, and its
resolution is 300dpi. If you have no idea what any of this means, you lack
the skills and knowledge needed to include graphics in your Kindle book;
you can omit them from your manuscript, brush up your graphics editing
skills, or get a more knowledgeable person to edit the images for you.

8) Format around any graphics or illustrations

a) Surround any full-page size images (approximately 4x6” is the ideal size
for a full-page illustration) with page breaks, to force each such image
onto its own page and prevent unwanted, stray text from showing up on
those pages. If you have color versions of the images, use them.

b) Surround any other images with carriage returns, to prevent any text
wrapping or flowing around the images, and again, use color images
where possible. Note that while inserting the carriage returns may result
in large areas of white space around your images, the white space is far
preferable to unpredictable text wrapping around the image when the
user decides to re-size the font displayed on his ereader device.

8.3. INSERT A HYPERLINKED TABLE OF CONTENTS

A hyperlinked table of contents is required for all Kindle books, and that includes novels.

This is because it’s needed to create the required “active” table of contents file (toc.ncx,

used to display the progress bar on the Kindle screen), as discussed previously.

Fortunately, it’s very easy to create a hyperlinked Table of Contents in Word.

1) Ensure each chapter of your manuscript has a chapter number or title on its
first page, and that the number or title is formatted as "Heading 1" style
(select the text, then click Format > Styles and Formatting, and select the
"Heading 1" style from the list provided to make the chapter number/title a
Heading).

If you don't like the way "Heading 1" looks, you can right-click on "Heading
1" in the Styles list and select "Modify" to use all the usual text formatting
tools (i.e., font, size, bold, paragraph spacing, indent type, etc. etc.), but
remember to stick to formatting that will be HTML-friendly.

2) Go to the page where you want the table of contents and label it with the
title “Table of Contents”, or just “Contents”, in a font size of 14pt or less.
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Beneath the title, enter a couple of carriage returns, then click in the desired
position for your table of contents on the page.

3) Click Insert > Reference > Index and Tables > Table of Contents tab. Click
the boxes for "Show Page Numbers," "Right-Align Page Numbers," and "Use
Hyperlinks Instead of Page Numbers". Also set the "Show Levels" drop-down
to "1". Click “Apply” to save these changes.

8.4. SAVE IN .DOC FORMAT

If you’re using Word 2007 or above, which saves its files in .docx format by default, do a

“Save As” in the older, .doc format. This is the format that (as of this writing) works best

with Mobipocket Creator, the program you’ll be using to convert your Word document

into .prc format for upload to the DTP (see next section). You may get a warning pop-up

telling you that features specific to your version of Word will be lost in the new

document, but since your cleaned-up document doesn’t contain any features specific to

your version of Word, this is a non-issue. Click “OK” to bypass any such warning pop-

ups.

9. DOWNLOAD THE MOBIPOCKET CREATOR AND AMAZON KINDLE

PREVIEWER PROGRAMS

Kindle books are published in a proprietary, or Amazon-specific, version of the

Mobipocket .prc format. Therefore, if you can convert your file to .prc format before you

upload it to the DTP, there will be no significant changes made to the file during the

Kindle conversion process, and the Kindle book should look and behave exactly the

same as the .prc book does. Predictability is a very good thing in Kindle publishing; it

saves you a whole lot of time and frustration in what can otherwise be a repeated

exercise of the trial and error approach.

Fortunately, converting your cleaned-up Word file to prc format is very easy and free

when you use the Mobipocket Creator program. As of this writing you can download it at

http://www.mobipocket.com/en/downloadsoft/productdetailscreator.asp, but if that link

becomes broken at some point in the future you can just do a Google search on

“Mobipocket Creator” to find the program. Be sure to download the “Publisher Edition”

of the program, as different versions of the software are available.
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You’ll also need the free Amazon Kindle Previewer, even if you already own a Kindle.

This is because the Kindle Previewer has a special “NCX view” button that the Kindle

device and Kindle reader apps do not. As of this writing, that “NCX view” button is the

only way you can actually view and test the menu created by your toc.ncx file before

publishing the Kindle book. If the menu looks correct and its hyperlinks function properly

(more about this in section 11), you can be confident your Kindle book’s progress bar

will work properly, too.

As of this writing, the Previewer program is provided by Amazon at

http://amazon.com/kindlepublishing. If that link should become broken at some point,

just do a Google search on “Kindle Previewer” to locate the program.

Download one or both programs, as applicable, and install them.

10. USE MOBIPOCKET CREATOR TO MAKE A .PRC VERSION

You’ll be using the Mobipocket Creator program to create a .prc version of your book for

upload to the Amazon DTP. This is a much simpler and more controlled method than

doing a “save as” HTML in Word, then uploading and previewing the HTML on the DTP,

making any necessary changes to correct issues seen in the preview, and repeating the

process as many times as necessary until you’re happy with the book. With this method,

you can see exactly how the book will look and perform before you upload it to the DTP.

10.1. IMPORT YOUR WORD FILE TO MOBIPOCKET CREATOR

One of the options on the startup screen of Mobipocket Creator is “Import From Existing

File” > “MS Word document”. Click on this item and navigate to the .doc file you saved

at the end of the previous section.
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Mobipocket Creator will crunch away on the .doc file and convert it to an HTML file:
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10.2. ADD A COVER IMAGE AND METADATA

Now, you’re going to click on those menu links at the left-hand side to provide additional

content and information about your book. First, your cover image. You should already

have a 4x6” version of it at 300dpi, and that’s what you’ll be uploading here:
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If it looks good, click the Update button to add it to your book, and you’ll be dropped

back on the Publication Files page:

Now click the Book Settings link. Here is where you’ll provide more information about

your book, a brief description of its content, your intended retail list price, and so on.

Note that the only required fields are those marked with a red asterisk. Also note that

the “retail price” you list here is only a “suggested” retail price, it has no bearing on the

price you ultimately set for the book in Amazon’s Kindle store, or anywhere else.
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Scroll down to be sure you’ve filled in all the required fields; you’ll find the cover image

you uploaded is already present in the form. If there are any fields for which you’re

unsure what information to provide, just skip them. Finally, click the Update button to

save your changes:
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10.3. EDIT THE HTML FILE TO ADD ANCHORS

Okay, here’s where things can get a bit scary for people who aren’t used to working with

computer files or HTML. But don’t worry, the editing you need to do is minimal and you

only need a text editor program (e.g., Notepad) to do it.

When you inserted the hyperlinked table of contents in Word, Word inserted a bunch of

invisible markers, known as “anchors” in HTML-speak, right in front of each chapter

heading and any other headings included in the table of contents. These anchors are

used to create hyperlinks in your table of contents, and also to create the tick marks on

the Kindle’s progress bar, which was discussed earlier.

There are some pages in the ebook which need to have tick marks on the progress bar

of the Kindle, but which you wouldn’t want included in your hyperlinked table of

contents. In this step, you’ll be manually inserting these additional anchors in the HTML

file. At the minimum, you must insert anchors to indicate the actual start point of the

book (usually, this is the cover image page) and the table of contents page. You may

also want to include anchors for other pages which aren’t included in your book’s table

of contents, such as the copyright page, the dedication page, or an About the Author

page at the back of the book.

When you installed MobiPocket Creator, it added a subfolder called “My Publications” to

your Documents folder. When you imported your Word file, it created a subfolder within

the My Publications folder, named to match the title of your book. In that folder, you’ll

find the HTML file Mobipocket Creator created from your Word file import:
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In Windows, right-click on the file and select Open With > Notepad:

In other operating systems, start your text editor program—it must be a PLAIN TEXT

editor program, not MS Word or some other full-function word processor—and click File

> Open, then navigate to the HTML file.

When you open the file, it will look like this:
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All that HTML code is kinda scary, I know, but take a deep breath: you’ll get through

this.

First, you need to insert an anchor to indicate the start of the book. In your text editor,

click on Edit > Find:
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Recall that your first page has your book’s cover image on it. In HTML, this is designated

with an “image tag”. All image tags begin with the characters, “<img”.

So to find the first page of your book with an image on it, all you need to do is enter

those characters in the Find box, as shown in the next screenshot.

C

l

i

c

k

F

i

n

d

Click on Find Next and your cursor will be taken right to that first image tag, where your

book cover appears on the first page of your book (highlighted in blue below):
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Click Cancel to close the search box, then click to place your cursor right at the start of

that line of HTML code, before the “<p”, and enter this exact text to insert an anchor:

<a name="start"></a>

This is shown below, in an enlarged view, highlighted in blue.

In your text editor, click on File > Save to save your changes before proceeding.

Okay, one anchor down, only one more (that’s required) to go. Click on Edit > Find

again to re-open the search box. This time, you want to search for your table of

contents page. Assuming you’ve labeled it with the words “Table of Contents” or

“Contents” as per these instructions, all you need do is search on that string:
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Just as before, close the search box and then click to position your cursor just ahead of

the “<p” at the start of this part of the HTML code, and enter the following text exactly:

<a name=”toc”></a>

Again, this is shown enlarged in the screen shot below:

Click File > Save to save your changes, and if these are all the anchors you intend to

insert, close the file. If you’re not used to working with HTML files and are feeling a little
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out of your depth at this point, I recommend you stop while you’re ahead and don’t try

to insert any more, optional anchors.

Otherwise, if you’d like to insert anchors on other pages so they’ll be added as tick

marks on the progress bar as well, just follow the same steps you did for the “start” and

“toc” anchors. To find the correct location(s) for anchor placement in the HTML file, just

search for text you know appears on the page where you want the anchor.

Be sure to insert your anchors immediately before the “<p” at the start of the applicable

section of HTML code, and label them with meaningful and easy to remember names

(e.g., <a name=”dedication”></a> for the dedication page, <a

name=”aboutauthor”></a> for the About the Author page, etc.). Make a side note of

how you’ve named each of these additional, optional anchors because you’ll need to

enter them in Mobipocket Creator in an upcoming step. Finally, save and close the file.

10.4. CREATE GUIDE LINKS

Go back to Mobipocket Creator and click on the Guide link at the left. This will open the

Guide creation page:
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You will need to enter a “guide item” here for every anchor you’ve added to the HTML

file in the previous step. To get started, click the New guide item button. When you do,

some new text entry fields will be shown:

For the first one, enter “Start” in the Title field and drop down the pick list in the Type

field, where you can select “start” from the pre-populated list of options:

For Filename, you will need to Browse to the HTML version of your book file and select it

to have it entered in the Filename field (remember, the HTML file is stored in a subfolder
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of the My Publications folder), then add the anchor name to the end of the filename.

Anchors are referenced in HTML files with a pound sign, as follows:

[HTML file name].html#[anchor name]

In the screen shot below, I’ve navigated to the HTML file of my sample Kindle book,

selected it, and have manually typed the characters “#start” at the end:

Click New guide item and repeat the process for the “toc” anchor. For Title, enter “Table

of Contents”. In the Type drop-down, select “toc”. Navigate to the HTML file and select

it as before to fill the Filename field, then manually add “#toc”. You can also just copy

the Filename previously entered for Start and edit the anchor name at the end.

All of this is shown in the screenshot below:
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Follow the same steps to add guide items for any additional anchors you’ve added to the

HTML file. You’ll find there are Type items already in the list for all of the most common

types of ebook guide items, but if you can’t find one that matches your Title (or closely

approximates it, they don’t have to be an exact match), just select “text” from the Type

list.

When you’re finished adding guide items on this screen, click Update. Again, you’re

returned to the Publication Files screen. On that screen, click the Save link (indicated by

a diskette icon in the top menu bar of the screen, underlined in screenshot below).
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It won’t look like anything’s changed, but if you navigate to the folder where your HTML

file is stored, you’ll find there’s a new file there with an .opf extension:

This where Mobipocket stores all that information you entered in the Metadata and

Guide screens; the file will need some minor edits after you’ve created and saved your

toc.ncx file, to ensure the two files’ data match. For now, just leave it there in the

subfolder.

10.5. CREATE THE TOC.NCX FILE

The toc.ncx file is a file containing specific computer code that tells ereader devices how

to put together and display that special ‘menu’ file that was discussed earlier. The file is
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broken down into four major sections: information about the computer language used in

the file, a “head” section, a section with the author name and book title, and a “navMap”

section.

You won’t be making any changes to the section about the computer language or the

“head” section, those sections contain identical boilerplate for all ebooks:

<!DOCTYPE ncx PUBLIC "-//NISO//DTD ncx 2005-1//EN"

"http://www.daisy.org/z3986/2005/ncx-2005-1.dtd">

<ncx xmlns="http://www.daisy.org/z3986/2005/ncx/"

version="2005-1" xml:lang="en-US">

<head>

<meta name="dtb:uid" content="uid"/>

<meta name="dtb:depth" content="1"/>

<meta name="dtb:totalPageCount" content="0"/>

<meta name="dtb:maxPageNumber" content="0"/>

</head>

In the section about the author name and book title, obviously, you’ll enter your author

name and book title.

<docTitle><text>[Book Title]</text></docTitle>

<docAuthor><text>[Author Name]</text></docAuthor>

The <navMap> section is where you will list all the anchors in your book’s HTML file.

The concept is pretty simple: there must be one “navPoint” created for each anchor in

the HTML file. Therefore, you’ll be listing a navPoint for each anchor Word created when

you inserted the hyperlinked table of contents in your manuscript file, as well as for any

anchors you created yourself.

A toc.ncx shell is provided on the following page, with the “start” and “toc” navPoints

already in it (other than inserting your book's filename, leave these as-is when you’re

editing), and a placeholder for the first chapter navPoint. You can copy the text below

into Notepad or any other plain text editor, save it as “toc.ncx” in the same folder as

your book’s .html and .opf files, and you’ll have a starting point for your toc.ncx file.
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<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE ncx PUBLIC "-//NISO//DTD ncx 2005-1//EN"

"http://www.daisy.org/z3986/2005/ncx-2005-1.dtd">

<ncx xmlns="http://www.daisy.org/z3986/2005/ncx/"

version="2005-1" xml:lang="en-US">

<head>

<meta name="dtb:uid" content="uid"/>

<meta name="dtb:depth" content="1"/>

<meta name="dtb:totalPageCount" content="0"/>

<meta name="dtb:maxPageNumber" content="0"/>

</head>

<docTitle><text>[Book Title]</text></docTitle>

<docAuthor><text>[Author Name]</text></docAuthor>

<navMap>

<navPoint id="titlepage" playOrder="1">

<navLabel><text>Title Page</text></navLabel>

<content src="[filename].html#start"/>

</navPoint>

<navPoint id="toc" playOrder="2">

<navlabel><text>Table of Contents</text></navLabel>

<content src="[filename].html#toc"/>

</navPoint>

<navPoint id="navpoint-1" playOrder="3">

<navlabel><text>[Chapter Title]</text></navLabel>

<content src="[filename].html#[anchor name copied from toc]"/>

</navPoint>

</navMap>

</ncx>
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10.6. EDIT THE TOC.NCX FILE

Add navPoints to this file as necessary. To create a navPoint for all of your chapter

headings and any additional anchors, copy and paste the following text block into your

toc.ncx file immediately between the last </navPoint> tag in the file and the

</navMap> tag, then edit the text items shown in brackets per the instructions that

follow (and don’t forget to delete the brackets themselves as you edit). Notice that the

text block provided below contains a blank line above the navPoint and another blank

line below the navPoint; include these blank lines when you copy and paste.

<navPoint id="navpoint-[number]" playOrder="[number]">

<navlabel><text>[Chapter Title]</text></navLabel>

<content src="[filename].html#[anchor name copied from toc]"/>

</navPoint>

In each navPoint, the “navPoint id” field is either a specific title assigned to the anchor,

such as “start” or “toc”, or a more generic identifier consisting of “navpoint-“ followed by

a number. Because the “start” and “toc” navPoints have already been created for you in

the file, all the navPoints you add will be of the latter, generic type. Here is an example

of what the navPoints would look like for chapters entitled Chapter 2 and Chapter 3 if

you added them to the sample toc.ncx provided on the previous page:

<navPoint id="navpoint-2" playOrder="4">

<navlabel><text>Chapter 2</text></navLabel>

<content src="[filename].html#[anchor name copied from toc]"/>

</navPoint>

<navPoint id="navpoint-3" playOrder="5">

<navlabel><text>Chapter 3</text></navLabel>

<content src="[filename].html#[anchor name copied from toc]"/>

</navPoint>

Notice how the “navpoint-[number]” and playOrder=”[number]” items are incremented

by one for each new navPoint added. While the navpoint-[number] happens to match
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my chapter numbers in this example, that’s only because I haven’t added any navPoints

for extra anchors between the Table of Contents and first chapter.

If my book had a Foreword between the ToC and first chapter, and I’d inserted an

anchor for it, a navPoint for that anchor would be inserted between the “toc” navPoint

and the first chapter navPoint. The Foreword navPoint would be listed as “navPoint-1”

and the chapter 1 navPoint would be listed as “navPoint-2”.

Add navPoints for each anchor or chapter heading in your book in the order they appear

in the book, and edit them to reflect the correct chapter names, navPoint id numbers

and PlayOrder numbers. And as when editing any important file, save your work

frequently to avoid unexpected data loss.

10.7. INSERT ANCHOR NAMES COPIED FROM WORD’S TABLE OF

CONTENTS

At this point your toc.ncx file should have all its navPoints in place, and all the navPoints

should have correct navPoint id numbers and PlayOrder numbers. But what about this

line in each navPoint?

<content src="[filename].html#[anchor name copied from toc]"/>

As you’ve probably guessed, you’ll need to insert your book’s HTML filename where

[filename] currently appears.

The [anchor name copied from toc] item is bit more of a pain. Recall that when you

inserted a hyperlinked table of contents in your Word document, Word created anchors

for each of your chapter headings at the start of each chapter and inserted them

immediately before each chapter title. Then, Word created links to all those anchors in

your document’s table of contents. All you need to do is find out what name Word gave

to each of those anchors and then type or paste the anchor names into each respective

navPoint in your toc.ncx file. For that, you’ll need to re-open your book’s HTML file,

again in a plain text editor like Notepad.
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Once the file is open, use Edit > Find to search for the toc anchor you created

previously. You’re looking for this text:

<a name=”toc”>

Here it is, in the HTML file:

See those blocks of code that begin with “<p class=”? There’s one for each item in the

hyperlinked table of contents, and each block contains an anchor hyperlink name. Let’s

take a closer look at the first two blocks, for Chapter 1 and Chapter 2.

<p class="TOCText"><span style="mso-bookmark:_Toc78049688"><span style="mso-
bookmark:_Toc123071064"><span style="mso-
bookmark:_Toc123540857"></span></span></span><a href="#_Toc269068387"><span
style="mso-bookmark:_Toc78049688"><span style="mso-bookmark:_Toc123071064"><span
style="mso-bookmark:_Toc123540857">Chapter
1</span></span></span></a><span style="mso-bookmark:
_Toc78049688"><span style="mso-bookmark:_Toc123071064"><span style="mso-bookmark:
_Toc123540857"></span></span></span></p>

<p class="TOCText"><span style="mso-bookmark:_Toc78049688"><span style="mso-
bookmark:_Toc123071064"><span style="mso-
bookmark:_Toc123540857"></span></span></span><a href="#_Toc269068388"><span
style="mso-bookmark:_Toc78049688"><span style="mso-bookmark:_Toc123071064"><span
style="mso-bookmark:_Toc123540857">Chapter
2</span></span></span></a><span style="mso-bookmark:
_Toc78049688"><span style="mso-bookmark:_Toc123071064"><span style="mso-bookmark:
_Toc123540857"></span></span></span></p>
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The chapter name is given in each block, and the associated anchor name appears

above the chapter name in the block, in a “<a href=” tag.

In the examples above, the anchor name for Chapter 1 is “#_Toc269068387” and the

anchor name for Chapter 2 is “#_Toc269068388”. There are some other “_Toc” –type

numbers in each block, but the only one you’re interested in is the one in the “<a href=”

tag.

It’s clear that Word uses some kind of automated numbering process to create these

anchor names, because they’re pretty long and unwieldy, but notice how the two anchor

name numbers are only off by one digit—the last digit. That’s right, Word assigns its

anchor numbers in numeric order. So once you know one the first one, you can simply

copy it into every chapter navPoint in your toc.ncx file, then edit each one for chapters 2

through your last chapter to increment each anchor name/number by one.

10.8. REPLACE SPECIAL CHARACTERS IN YOUR TOC.NCX FILE

Because toc.ncx is a computer code file, it can only have computer code characters in it.

This means that if there are any non-alphabetic, non-numeric characters in your toc.ncx

file, they will have to be replaced by the HTML code equivalent. This occurs most

frequently in chapter titles, where you may have used apostrophes, colons, semicolons,

ampersands (&) or other punctuation.

The following table lists some of the most common special characters and their HTML

equivalents. Simply replace any special characters in your chapter names with the

corresponding code from the table. If you don’t find the character you need in this table,

do a Google search on “ASCII codes” to find more reference tables online.
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Character HTML Equivalent Character HTML Equivalent

&nbsp; : &#58;

( &#40; ; &#59;

) &#41; < &#60;

* &#42; = &#61;

+ &#43; > &#62;

, &#44; ? &#63;

- &#45; @ &#64;

. &#46; [ &#91;

/ &#47; \ &#92;

! &#33; ] &#93;

" &#34; ^ &#94;

# &#35; _ &#95;

$ &#36; ` &#96;

% &#37;

& &#38;

' &#39;

For example, if your original navPoint looks like this:

<navPoint id="navpoint-1" playOrder="3">

<navlabel><text>Jimmy’s Test: It’s A Killer!</text></navLabel>

<content src="MyBook.html#_Toc269068387"/>

</navPoint>

When you’ve replaced the special characters it should look like this:

<navPoint id="navpoint-1" playOrder="3">

<navlabel><text>Jimmy&#39;s Test&#58; It’s A Killer&#33;</text></navLabel>

<content src="MyBook.html#_Toc269068387"/>

</navPoint>
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10.9. VERIFY YOUR TOC.NCX FILE

Since you know the navPoint id numbers and PlayOrder numbers, and you know that

Word table of contents anchor names are all supposed to increment by one in each

navPoint block, you can do a quick verification of your toc.ncx by looking it over to

ensure all those numbers are properly incremented from navPoint block to navPoint

block.

Make any needed corrections, then save and close the file.

10.10. ADD THE TOC.NCX FILE TO YOUR MOBIPOCKET BOOK PROJECT

Go back into Mobipocket Creator; if you closed your book project file at some point, to

re-open it, click on File > Open and navigate to the .opf file for your book. Remember, it

will be in the same subfolder as your book’s HTML file.

Click on the Add Files link in the left-hand menu (in red below):

When prompted, navigate to your toc.ncx file and select it. Note that you may have to

drop down the ‘files of type’ list and set it to ‘all files’, as shown below:
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Once you do, you’ll be able to see your toc.ncx file; select it and click Open.

You’ll be taken back to the Publication Files screen, and it will look like nothing has

changed. Click the ‘Save’ icon in the menu bar, as you’ve done before. Again, it will look

like nothing happened.
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10.11. EDIT THE .OPF FILE TO MATCH YOUR TOC.NCX FILE

Go to the directory where your book’s HTML file is stored, and open the .opf file in

Notepad or any other plain text editor. It will look like this:

The only part you need to change is the <spine> section, near the end. To make it

easier to see and work with, and to ensure you don’t accidentally alter any other part of

the file, insert line breaks to offset the <manifest> and <spine> sections, like this:
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The line breaks and spaces you’ve introduced won’t affect how the file works.

Now, replace the <manifest> and <spine> sections with the following text blocks,

which will “tell” the opf file that your book has a separate toc.ncx file:

<manifest>
<item id="item1" media-type="text/x-oeb1-document" href="[filename].html"></item>
<item id="toc" media-type="application/x-dtbncx+xml" href="toc.ncx"></item>
</manifest>

<spine toc="toc">
<itemref idref="item1"/>
<itemref idref="toc"/>
</spine>

You’ll need to replace the highlighted part, which says [filename], with the actual name

of your book’s HTML file, and don’t forget to delete the brackets. It is critical that the

“itemref idref” items in the <spine> section exactly match the corresponding “item id”

items in the <manifest> section, so correcting the [filename] is the only change you

should be making here. If your .opf file has a <spine> or <manifest> section that
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differs significantly from what’s shown in the text blocks above, something has gone

wrong in your process up to this point. In that case, close the project and close

Mobipocket Creator, delete the subfolder containing this project’s files from the My

Publications folder, and start over at the beginning of this section.

As I said before, just one missing or incorrect character in a computer code file can

make the entire file nonfunctional, so attention to detail is key. When you’re done, save

and close the file.

10.12. BUILD THE .PRC BOOK IN MOBIPOCKET CREATOR

Go back into Mobipocket Creator; if you closed your book project file at some point, to

re-open it, click on File > Open and navigate to the .opf file for your book. Remember, it

will be in the same subfolder as your book’s HTML file.

Click on the Build icon in the top menu bar; it’s underlined in the screenshot below.

You’ll be taken to the Build screen. Leave all the settings at their default values, and

click Build.
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The process will take less than a minute, and will immediately tell you if any errors were

encountered. If there are any warnings listed after the Build is complete, click on the

Show Build Details button (highlighted in blue below) to view the error messages.

In this case, I’ve purposely skipped the ‘Cover Image’ step. The warning icon in the

Build Details log below shows the error:
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To correct this error I’d go back and add the cover image (via the Cover Image link at

the left-hand side of the Mobipocket Creator screen), then Save the project.

Note that any time you correct an error, you must go back to step 10.11 and verify your

.opf file <manifest> and <spine> changes haven’t been overwritten. Usually, you’ll find

they have been overwritten and you’ll need to repeat step 10.11 to re-correct the .opf

file.

If the error message is unclear to you, and you have no idea how to remedy the

problem, the simplest (if most tedious) solution is to close the project and close

Mobipocket Creator, delete the subfolder containing this project’s files from the My

Publications folder (not just the folder contents, you must delete the entire folder), and

start over at the beginning of this section.
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11. PREVIEW YOUR KINDLE BOOK

First, a little editorializing.

As a retired software engineer and web application developer, I can tell you that even

seasoned pros struggle with searching out and correcting those tiny, seemingly

insignificant errors that make their programs crash, so don’t beat yourself up if your

book doesn’t look or work right the first time.

Okay, moving on…

Start up your Kindle Previewer program, then use File > Open Book to navigate to your

book’s .prc file and select it.

Here’s my sample book, opened in Kindle Previewer.
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Notice how the cover image is shown in grayscale, even though the cover image I

added in Mobipocket Creator was in full color. This is because the Previewer emulates

how the book will look on a real Kindle device, and those devices do not display

anything in color.

You can now page through your book in the Previewer, check out your table of contents

and ensure its hyperlinks function properly, and verify any images in the book are

present and clear.

11.1. VERIFY YOUR TABLE OF CONTENTS

The three menu bar buttons to the right are to jump to the Cover Image, Table of

Contents, and NCX View, respectively. In the screenshot below, I’ve moused over the

Table of Contents button to highlight it.
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You’ll find that if you click on that button, you’ll get an error message saying your book

has no table of contents. This is because you did not add a separate table of contents

file in Mobipocket Creator. However, the reason why you didn’t do so is because your

Word file already had a hyperlinked table of contents before you imported it to

Mobipocket Creator.

Use the right-pointing, single arrow in the menu bar to page forward to your book’s

table of contents. Once you’re on the table of contents page, test its hyperlinks by

clicking on them. You can quickly get back to the table of contents page by using the

scrollbar control at the bottom of the Previewer screen.

11.2. VERIFY YOUR TOC.NCX

Now comes the part where you’re most likely to encounter a problem…it’s time to verify

your toc.ncx file. To do so, click on the “NCX View” button at the far right-hand side of

the menu bar. In the screenshot below, I’ve moused over it to highlight it:
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If your toc.ncx is functioning properly, you should see something that looks like a table

of contents, but which contains all the anchors defined in the toc.ncx file, as shown in

the next screenshot.
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If this is what you’re seeing, test the NCX view by double-clicking on some of the items

displayed in its list and verifying that the hyperlinks work. You can easily get back to the

NCX View after following a hyperlink by clicking the NCX View button on the menu bar

again.

You can also see the infamous progress bar, for which you had to create the toc.ncx in

the first place, by scrolling the right-hand scroll bar all the way down:
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Notice how it has tick marks for each anchor in the toc.ncx file and indicates the reader’s

progress in the book.

11.2.1. IF NCX VIEW FAILS…

If you get an error message in Previewer when you click on the NCX View button,

the most likely cause is a mismatch between your .opf and .ncx files. The usual

error message is that there is no toc.ncx file, but don’t let that rattle you. It just

means the .opf file can’t find the toc.ncx, not that your painstakingly-created

toc.ncx has somehow been deleted.

Go back to section 10.11 and repeat all steps from that point on.

12. IF THERE ARE PROBLEMS…

Unfortunately, there’s not a lot of specific, step-by-step advice I can offer for debugging

your book because there are too many different things that can go wrong for me to

address them all here. As I said at the outset, this process is not for the tech faint of

heart; if your project isn’t coming together and you’re not well-versed in editing HTML
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and other computer code files, your best bet is to outsource the conversion job to

someone else who is comfortable with those tasks.

You can always delete your Mobipocket Creator book project subfolder (not just the

files, the entire subfolder), go back to the beginning of section 8 and start all over again

with the formatting and conversion process, but it will be time consuming and there’s no

guarantee it will resolve your issue.

13. READY, SET, DTP!

Go to http://dtp.amazon.com and login. If you don’t already have an Amazon account,

follow the link on the DTP home page to create one. If you do already have an Amazon

account (used for purchasing items from Amazon or for a Kindle device), you will use

that same account to login to the DTP. On your DTP “Bookshelf”, click the “Add new

title” button to get started.

You’ll have to page through several screens of data entry to create your book project; at

the bottom of each screen there’s a “Save and Continue” button and a “Save as Draft”

button. Use the “Save as Draft” button to save any entries you’ve made but get out of

the book setup screens without going all the way through to publishing the Kindle book.

This can be handy when you need to tinker with your book’s cover image or description

a bit more prior to publishing, or if there’s any other reason why you don’t want to

publish the book right away.

The details of how to fill out the required fields for DTP processing are already covered

in the Amazon DTP guides I’ve mentioned previously, and I will not rehash them here.

Just note that only fields marked with a red asterisk are required, so don’t feel obligated

to make up a Publisher Name, or a Series Name if it’s really not applicable to your book.

For my DTP books, I left the ISBN, Publisher Name, Series Title and Series Volume all

blank. I entered “1” for Edition Number, and I entered as many search keywords (e.g.,

comic fiction, mystery, Midwest, womens fiction, etc.) as I could possibly think of that

would fit in the space provided. The keywords will help customers find your book when

they search the store, so don’t be afraid to really go nuts with them. More keywords =

more people finding your book. Also note that when it comes to filling in your Book
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Description field, all you have to do is copy the description you created previously and

paste it into the field.

Note that you will need to verify your rights to the book’s content, select an author

royalty percentage, and specify whether or not you want your Kindle book to be sold on

Amazon sites other than the U.S. site. As of this writing you can only opt in for

Amazon.co.uk, but it’s likely that you’ll be able to opt in for other Amazon international

sites in the future as well.

Follow the instructions to “Enter Product Details” and “Upload & Review Book” as

outlined in the Amazon DTP guides—skipping the Preview part of those directions, since

you’ve already previewed your book in the Kindle Previewer.

14. SET YOUR PRICE AND PUBLISH!

Bestsellers that are only available in hardcover in the ‘regular’ book store tend to be

priced at $9.99 in the Kindle store, and those available as trade paperbacks in the

‘regular’ bookstore usually run between $6.99 - $8.

For indie authors, it seems as if the pricing “sweet spot” for a Kindle book is $2.99.

When mainstream-published author JA Konrath began self-publishing some of his works

via the DTP, he did quite a bit of experimentation with price points. In the end, he found

that pricing his Kindle books at $3.99 or higher seemed to discourage some purchases,

while reducing them to $1.99 or less didn’t seem to stimulate additional sales to any

significant extent.

Feel free to do your own experimenting with various price points, but be warned: any

time you change anything about your Kindle book, even if it’s just the price, you will

have to re-publish the book. Re-publishing makes the book unavailable for purchase on

Amazon for up to three business days.

Log back in to the DTP in about three days to see if your book is marked “Live” yet. First

it will go “Live”, but not all the details will show up on the product page and it will be

listed as “not yet available” while Amazon works to get your book’s details added to all
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their various databases. By the end of five business days at most, your book should be

live, complete and available for sale in the Kindle store.

15. AFTER YOUR BOOK IS PUBLISHED

You can log back into your DTP dashboard anytime you want and click on the “My

Reports” tab to see how many copies of your book have sold and what your cumulative

author royalty total is to date.

You can also re-upload and re-publish revised versions of your Kindle books at any time,

but if you’ve done everything according to this guide, it should never be necessary.

Finally, send an email to everyone you know, with a link to your book’s product page on

Amazon. By gum, you’re a published author now!


